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Getting Started

 

Congratulations on purchasing AirPort Extreme. Read this 
guide to get started using it.

 

AirPort Extreme is based on the Institute of Electrical and Electronics Engineers (IEEE) 
draft 802.11n standard, the fastest wireless standard, which provides better 
performance and greater range than previous IEEE 802.11 standards. AirPort Extreme is 
compatible with computers using 802.11b and 802.11g, as well as computers using the 
802.11a wireless standards.

With AirPort Extreme, you can:

Â

 

Create a wireless network in your home, and then connect to the Internet and share 
the connection with multiple computers simultaneously. An entire family or office 
can be connected to the Internet at the same time.

Â

 

Connect AirPort Extreme to your Ethernet network. Wireless-equipped Macintosh 
computers or Windows XP computers can access an entire network without being 
connected by a cable.

Â

 

Connect a USB printer to your AirPort Extreme. All of the compatible computers on 
the AirPort network, both wireless and wired, can print to it.
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Â

 

Connect a USB hard disk to your AirPort Extreme. All of the compatible computers on 
the AirPort network, both wireless and wired, can access the information on the hard 
disk.

Â

 

Connect a USB hub to your AirPort Extreme, and then connect multiple USB devices, 
such as printers or hard disks. All of the computers on the network can access those 
devices.
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About AirPort Extreme

 

AirPort Extreme has five ports, located on the back side:

Â

 

One Ethernet Wide Area Network (WAN) port (<

 

) for connecting a DSL or cable 
modem, or for connecting to an existing Ethernet network 

Â

 

Three 10/100 Ethernet Local Area Network (LAN) ports (G

 

) for connecting Ethernet 
devices, such as printers or computers, or for connecting to an existing Ethernet 
network 

Â

 

One USB port (d

 

) for connecting a compatible USB printer, hard disk, or hub

Next to the ports is a reset button, which is used for troubleshooting your AirPort 
Extreme. The status light on the front of AirPort Extreme shows the current status.

Status light Internet WAN port

AC adapter

Power port USB port

Ethernet ports Reset button

Security slot
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About the AirPort Software

 

AirPort Extreme works with the AirPort software included on the AirPort Extreme CD. 

 

AirPort Utility

 

AirPort Utility helps you set up your AirPort Extreme to create a wireless network, 
connect to the Internet, and share a USB printer or hard disk. You can also connect 
your AirPort Extreme to your existing AirPort Extreme or AirPort Extreme wireless 
network to extend the range of your network using a Wireless Distribution System 
(WDS). Use the setup assistant in AirPort Utility to quickly and easily set up your 
AirPort Extreme and your wireless network.
AirPort Utility is also an advanced tool for setting up and managing AirPort Extreme 
and AirPort Express Base Stations. Use AirPort Utility to adjust network, routing, and 
security settings and other advanced options. 

Z

 

AirPort status menu in the menu bar

 

Use the AirPort status menu to switch quickly between AirPort networks, monitor 
the signal quality of the current network, create a computer-to-computer network, 
and turn AirPort on and off. The status menu is available on computers using
Mac OS X. 



 

 

 

Chapter 1   

 

Getting Started

 

7

 

What You Need to Get Started

 

To set up AirPort Extreme using a Macintosh, you must have the following:
Â

 

A Macintosh computer with an AirPort or AirPort Extreme Card installed to set it up 
wirelessly

Â

 

A Macintosh computer connected to AirPort Extreme with an Ethernet cable to set it 
up using Ethernet

Â

 

Mac OS X v10.4 or later

Â

 

AirPort Utility 5 or later

 

To set up AirPort Extreme using a Windows PC, you must have the following:
Â

 

A Windows PC with 300-MHz or higher processor speed

Â

 

Windows XP Home or Professional (with Service Pack 2 installed)

Â

 

AirPort Utility 5 or later

You can use AirPort Extreme with any wireless-enabled computer that is compliant 
with the IEEE 802.11a, 802.11b, 802.11g standards, or with draft 802.11n. To set up AirPort 
Extreme, your computer must meet the requirements listed above.

Install the AirPort software that came on the CD and follow the instructions on the 
following pages to set up your AirPort Extreme and your AirPort wireless network.

 

Plugging In AirPort Extreme

 

Before you plug in your AirPort Extreme, first connect the appropriate cables to the 
ports you want to use, including:

Â

 

An Ethernet cable connected to your DSL or cable modem (if you will connect to the 
Internet) to the Ethernet (WAN) port (<

 

)
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Â

 

A USB cable to the USB port (d

 

) and to a compatible USB printer (if you will print to a 
USB printer), a USB hard disk, or USB hub

Â

 

Any Ethernet devices to the Ethernet LAN (G

 

) ports

After you have connected the cables for all the devices you plan to use, connect the AC 
plug adapter, and plug AirPort Extreme into the wall. There is no “on” switch.

 

Important:  

 

Use only the AC adapter that came with your AirPort Extreme.

When you plug AirPort Extreme into the wall, the status light flashes green for one 
second, and then glows amber while it starts up. After it has started up completely, the 
status light glows solid green.

Power port Ethernet activity light

AC adapter
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When you connect Ethernet cables to the Ethernet LAN (G

 

) ports, the lights above the 
ports blink when there is network activity.

 

AirPort Extreme Status Lights

 

The following table explains AirPort Extreme light sequences and what they indicate.

 

What’s Next

 

After you plug in AirPort Extreme, use the setup assistant in AirPort Utility to set it up 
to work with your Internet connection, USB printer or hard disk, or an existing network. 
The AirPort Utility is located in the Utilities folder in the Applications folder on a 
Macintosh, and in Start > All Programs > AirPort on a computer using Windows XP.

See “AirPort Extreme Networks” on page 11 for examples of all the ways you can use 
AirPort Extreme, and information about how to set it up.

 

Light Status/description

 

Off

 

AirPort Extreme is unplugged.

 

Flashing green

 

AirPort Extreme is starting up. The light flashes for one second.

 

Solid green

 

AirPort Extreme is on and working properly. If you choose Flash 
On Activity from the Status Light pop-up menu (on the Base 
Station pane of AirPort settings in AirPort Utility), the status light 
may flash green to indicate normal activity.

 

Flashing amber

 

AirPort Extreme cannot establish a connection to the network or 
the Internet. See “Your AirPort Extreme Status Light Flashes 
Amber” on page 28.

 

Solid amber

 

AirPort Extreme is completing its startup sequence.

 

Flashing amber and green

 

There may be a problem starting up. AirPort Extreme will restart 
and try again.
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See “Setting Up AirPort Extreme” on page 20 to find out more about using AirPort 
Utility to set up your base station and wireless network.



 

2
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AirPort Extreme Networks

 

In this chapter you’ll find explanations of the different ways 
you can use AirPort Extreme.

 

This chapter gives examples of the different kinds of networks you can set up using 
AirPort Extreme. It provides diagrams and explanations of what you need to do to get 
your AirPort Extreme network up and running quickly.
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Using AirPort Extreme with Your Broadband Internet Service

 

When you set up AirPort Extreme to provide network and Internet access, Macintosh 
computers with AirPort and AirPort Extreme Cards, and 802.11b, 802.11g, and 802.11n 
wireless-equipped computers can access the wireless AirPort network to share files, 
play games, and use Internet applications like web browsers and email applications.

 

It looks like this:

DSL or cable modem Internet WAN port

to Internet

<
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To set it up:

 

1

 

Connect your DSL or cable modem to your AirPort Extreme Ethernet WAN (<

 

) port.

 

2

 

Open AirPort Utility (located in the Utilities folder in the Applications folder), select 
your base station, and then click Continue.

 

3

 

Follow the onscreen instructions to create a new network or join an existing one. (See 
“Setting Up AirPort Extreme” on page 20.)

Computers using AirPort and computers using other wireless cards or adapters connect 
to the Internet through AirPort Extreme. Computers connected to AirPort Extreme 
Ethernet ports can also access the network and connect to the Internet.

Wireless computers and computers connected to the Ethernet ports can also 
communicate with one another through AirPort Extreme.
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Using AirPort Extreme to Share a USB Printer

 

When you connect a USB printer to your AirPort Extreme, all computers on the network 
(wired and wireless) can print to it.

 

It looks like this:

USB port

Shared printer

d
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To set it up:

 

1

 

Connect the printer to the AirPort Extreme USB port (d

 

) using a USB cable.

 

2

 

Open AirPort Utility (located in the Utilities folder in the Applications folder), select 
your base station, and then click Continue.

 

3

 

Follow the onscreen instructions to create a new network.

 

To use the printer connected toa computer using Mac OS X v10.2.7 or later:
1

 

Open Printer Setup Utility (located in the Utilities folder in the Applications folder).

 

2

 

Select the printer from the list.

If the printer is not in the list, click Add, choose Bonjour from the pop-up menu, and 
then select the printer from the list.

 

To use the printer connected to a computer using or Windows XP:
1

 

Install Bonjour for Windows from the CD that came with your AirPort Extreme.

 

2

 

Follow the onscreen instructions to connect your printer.
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Using AirPort Extreme to Share a USB Hard Disk

 

When you connect a USB hard disk to your AirPort Extreme, all computers on the 
network (wired and wireless) can connect to the hard disk to access, share, and store 
files.

 

It looks like this:

Shared hard disk drive

USB portd
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To set it up:

 

1

 

Connect the hard disk to the AirPort Extreme USB port (d

 

) using a USB cable.

 

2

 

Open AirPort Utility (located in the Utilities folder in the Applications folder), select 
your base station, and then click Continue.

 

3

 

Follow the onscreen instructions to create a new network.

Computers can access the hard disk to share or store files using Mac OS X v10.4 or later, 
or Windows XP (with Service Pack 2).

 

To access the hard disk from a computer using Mac OS X:
1

 

From the Finder, choose Go > Connect to Server.

 

2

 

Click Browse, select the name of your base station, and then click Connect.

 

3

 

Select Guest to connect to the hard disk.

 

To access the hard disk from a computer using Windows XP:
1

 

Right-click on My Computer and choose Map Network Disk.

 

2

 

Enter the base station’s IP address and share name.
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Using AirPort Extreme with Your AirPort Network

 

The illustration below shows a wireless network utilizing all the capabilities of AirPort 
Extreme.

DSL or cable modemto USB port

to USB port

USB hub to Internet

to Ethernet
port

AirPort Extreme

Shared hard
disk drive

Shared
printer
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To set it up

 

1

 

Connect all the devices you plan to use in your network.

 

2

 

Open AirPort Utility (located in the Utilities folder in the Applications folder), select 
your base station, and then click Continue.

 

3

 

Follow the onscreen instructions to set up your network. (See “Setting Up AirPort 
Extreme” on page 20.)



 

3
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Setting Up AirPort Extreme

 

This chapter provides information and instructions for using 
AirPort Utility to set up your AirPort Extreme.

 

Use the diagrams in the previous chapter to help you decide where you want to use 
your AirPort Extreme, and what features you want to set up on your AirPort network. 
Then use the instructions in this chapter to easily configure AirPort Extreme and set up 
your AirPort network.

This chapter provides an overview for using the setup assistant in AirPort Utility to set 
up your network and other features of your AirPort Extreme. For more detailed wireless 
networking information, and for information about the advanced features of AirPort 
Utility and AirPort Express, refer to the “Designing AirPort Networks” document, located 
on the AirPort Extreme CD and at www.apple.com/airportextreme.

You can do most of your network setup and configuration tasks using the setup 
assistant in AirPort Utility. To set advanced options, choose Manual Setup from the Base 
Station menu of AirPort Utility. See “Setting Advanced Options” on page 23.
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Using the AirPort Utility

 

To set up and configure your AirPort Extreme to use AirPort for wireless networking 
and Internet access, use the setup assistant in AirPort Utility. AirPort Utility is installed 
on your computer when you install the software on the AirPort Extreme CD.

 

On a Macintosh computer using Mac OS X v10.3 or later:
1

 

Open AirPort Utility, located in the Utilities folder in your Applications folder.

 

2

 

Select your base station, and then click Continue.

 

3

 

Follow the onscreen instructions to set up your AirPort Extreme and your wireless 
network.

 

On a computer using Windows XP (with Service Pack 2):
1 Open AirPort Utility, located in Start > All Programs > AirPort.

2 Select your base station, and then click Continue.

3 Follow the onscreen instructions to set up your AirPort Extreme and your wireless 
network.
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The setup assistant in AirPort Utility asks you a series of questions about the type of 
network you want to use and the services you want to set up. The setup assistant helps 
you enter the appropriate settings for the network you are setting up.

If you are using AirPort Extreme to connect to the Internet, you need a broadband (DSL 
or cable modem) account with an Internet service provider, or a connection to the 
Internet using an existing Ethernet network. If you received specific information from 
your ISP (such as a static IP address or a DHCP client ID), you may need to enter it in 
AirPort Utility. Have this information available before you set up your AirPort Extreme.

Creating a New Wireless Network
You can use the setup assistant in AirPort Utility to create a new wireless network. The 
setup assistant guides you through the steps necessary to name your network, protect 
your network with a password, and set other options.

If you plan to share a USB printer or USB hard disk on your network:

1 Connect the printer or hard disk to the AirPort Extreme USB port (d).

2 Open AirPort Utility, located in Utilities folder in the Applications folder on a Macintosh, 
or in Start > All Programs > AirPort on a computer using Windows XP.

3 Follow the onscreen instructions to create a new network.

Configuring and Sharing Internet Access
If you plan to share your Internet connection with wireless-enabled computers on your 
network or computers connected to the Ethernet ports, you need to set up your 
AirPort Extreme as an AirPort Base Station. After it is set up, computers access the 
Internet via the AirPort network. The base station connects to the Internet and 
transmits information to the computers over the AirPort network.
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Before you use the AirPort Utility to set up your base station, connect your DSL or cable 
modem to the AirPort Extreme Ethernet WAN port (<). If you are using an existing 
Ethernet network with Internet access to connect to the Internet, you can connect the 
AirPort Extreme to the Ethernet network instead.

Use the setup assistant in AirPort Utility to enter your ISP settings and configure how 
AirPort Extreme shares the settings with other computers.

1 Open AirPort Utility, located in Utilities folder in the Applications folder on a Macintosh, 
or in Start > All Programs > AirPort on a computer using Windows XP.

2 Select your base station, and then click Continue.

3 Follow the onscreen instructions to configure and share Internet access on your AirPort 
Extreme.

Using the setup assistant in AirPort Utility is a quick and easy way to set up your base 
station and network. If you want to set additional options for your network, such as 
restricting access to your network, or setting advanced DHCP options, you can choose 
Manual Setup from the Base Station menu of AirPort Utility. See “Setting Advanced 
Options” on page 23.

Setting Advanced Options
To set advanced options, you can use AirPort Utility to set up your AirPort Extreme 
manually. You can configure advanced base station settings, such as advanced security 
options, closed networks, DHCP lease time, access control, power controls, setting up 
user accounts, and more.
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To set advanced options:
1 Choose the wireless network you want to change. On a Macintosh, use the AirPort 

status menu in the menu bar. On a computer using Windows XP, hold the pointer over 
the wireless connection icon until you see your AirPort network name (SSID), and 
choose it from the list if there are multiple networks available.

2 Open AirPort Utility, located in the Utilities folder in the Applications folder on a 
Macintosh, and in Start > All Programs > AirPort on a computer using Windows XP.

3 If there is more than one base station in the list, select the base station you want to 
configure. If you don’t see the base station you want to configure, click Rescan to scan 
for available base stations, and then select the base station you want.

4 Choose Manual Setup from the Base Station menu. If you are prompted for a password, 
enter it.

For more information and detailed instructions for using the manual setup features in 
AirPort Utility, see the “Designing AirPort Networks” document, located on your AirPort 
Extreme CD and at www.apple.com/airport.



4
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4 Tips and Troubleshooting

You can quickly solve most problems with AirPort Extreme by 
following the advice in this chapter.

The AirPort Software Can’t Detect the Proper AirPort Hardware
Make sure that the computer you are using has an AirPort Card or an AirPort Extreme 
Card installed. If you recently installed the card, shut down your computer and make 
sure the card is properly installed. Make sure that the AirPort antenna is securely 
connected to the card (you should hear a click when the antenna is connected 
securely). Make sure that the other end of the card is firmly inserted into the connector 
in the AirPort Card slot.

If you are using a computer with Windows XP, make sure the wireless card or adapter is 
installed correctly. See the documentation that came with your computer to check the 
connection if you are using a computer with Windows XP. Also make sure you have 
installed Service Pack 2.
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You Forgot Your Network or AirPort Extreme Password
You can clear the AirPort network or base station password by resetting AirPort 
Extreme. 

To reset the base station password:
1 Use the end of a straightened paper clip to press and hold the reset button for one 

second. 

2 Select your AirPort network.

Â On a Macintosh, use the AirPort status menu in the menu bar to select the network 
created by AirPort Extreme (the network name does not change).

Â On a computer using Windows XP, hold the pointer over the wireless connection icon 
until you see your AirPort Network Name (SSID), and choose it from the list if there 
are multiple networks available.

3 Open AirPort Utility (in the Utilities folder in the Applications folder on a Macintosh, 
and in Start > All Programs > AirPort on a computer using Windows XP).

4 Select your base station and then choose Manual Setup from the View menu.

5 Click AirPort in the toolbar, and then click Base Station.

6 Enter a new password for the base station. 

7 Click Wireless and choose an encryption method from the Wireless Security pop-up 
menu to turn on encryption and activate password protection for your AirPort network. 
If you turn on encryption, enter a new password for your AirPort network.

8 Click Update to restart the base station and load the new settings.
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Your AirPort Extreme Isn’t Responding
Try unplugging it and plugging it back into a power outlet.

If your AirPort Extreme stops responding completely, you may need to reset it to the 
factory default settings. This erases all of the settings you’ve made and resets them to 
the settings that came with the AirPort Extreme.

To return AirPort Extreme to the factory settings:
m Use the end of a straightened paper clip to press and hold the reset button until the 

status light flashes quickly (about 5 seconds).

AirPort Extreme resets with the following settings:

Â AirPort Extreme receives its IP address using DHCP.

Â The network name reverts to Apple Network XXXXXX (where X is a letter or number).

Â The AirPort Extreme password returns to public.

If your base station is still not responding, try the following:
1 Unplug AirPort Extreme.

2 Use the end of a straightened paper clip to hold down the reset button while you plug 
in AirPort Extreme.
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Your AirPort Extreme Status Light Flashes Amber
The Ethernet cable may not be connected properly, AirPort Extreme may be out of 
range of an AirPort network, or there may be a problem with your Internet service 
provider. If you are connected to the Internet with a DSL or cable modem, the modem 
may have lost its connection to the network or the Internet. Even if the modem seems 
to be working properly, try disconnecting the modem from its power supply, waiting a 
few seconds, and then reconnecting it. Make sure AirPort Extreme is connected directly 
to the modem via Ethernet before reconnecting power to the modem.

For more information on the reason the light flashes, open AirPort Utility, select your 
base station, and then choose Manual Setup from the View menu. The information 
about the flashing light is displayed in the Summary pane.

Your Printer Isn’t Responding
If you connected a printer to the USB port on your AirPort Extreme and the computers 
on the AirPort network can’t print, try the following:

1 Make sure the printer is plugged in and turned on.

2 Make sure the cables are securely connected to the printer and to the AirPort Extreme 
USB port.
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3 Make sure the printer is selected in the Printer List window on client computers. To do 
this on a Macintosh using Mac OS X v10.3 or later:

Â Open Printer Setup Utility, located in the Utilities folder in the Applications folder.

Â If the printer is not in the list, click Add.

Â Choose Bonjour from the pop-up menu.

Â Select the printer, and then click Add.

To select your printer on a computer using Windows XP:

Â Open “Printers and Faxes” from the Start menu.

Â Select the printer. If the printer is not in the list, click Add Printer and then follow the 
onscreen instructions.

4 Turn off the printer, wait a few seconds, and then turn it on again.

I Want to Update My AirPort Software
Apple periodically updates AirPort software to improve performance or add features. 
It is recommended that you update your AirPort Extreme to use the latest software. To 
download the latest version of AirPort software, go to 
www.support.apple.com/airport.
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AirPort Extreme Placement Considerations
The following recommendations can help your AirPort Extreme achieve maximum 
wireless range and optimal network coverage.

Â Place your AirPort Extreme in an open area where there are few obstructions, such as 
large pieces of furniture or walls. Try to place it away from metallic surfaces.

Â If you place your AirPort Extreme behind furniture, keep at least at least an inch of 
space between the AirPort Extreme and the edge of the furniture. 

Â Avoid placing your AirPort Extreme in areas surrounded by metal surfaces on 
three or more sides. 

Â If you place your AirPort Extreme in an entertainment center with your stereo 
equipment, avoid completely surrounding AirPort Extreme with audio, video, or 
power cables. Place your AirPort Extreme so that the cables are to one side. Maintain 
as much space as possible between AirPort Extreme and the cables.

Â Try to place your AirPort Extreme at least 25 feet from a microwave oven and 2.4 or 5 
GHz cordless phones, or other sources of interference.

Items That Can Cause Interference with AirPort
The farther away the interference source, the less likely it is to cause a problem. The 
following items can cause interference with AirPort communication:

Â Microwave ovens

Â Direct Satellite Service (DSS) radio frequency leakage

Â The original coaxial cable that came with certain types of satellite dishes. Contact the 
device manufacturer and obtain newer cables.
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Â Certain electrical devices such as power lines, electrical railroad tracks, and power 
stations

Â Cordless telephones that operate in the 2.4 or 5 gigahertz (GHz) range. If you have 
problems with your phone or AirPort communication, change the channel your base 
station or AirPort Extreme uses, or change the channel your phone uses.

Â Nearby base stations using adjacent channels. For example, if base station A is set to 
channel 1, base station B should be set to channel 6 or higher.
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5 Learning More, 
Service, and Support

You can find more information about using AirPort Extreme on 
your hard disk, on the web, and in onscreen help.

Online Resources 
For the latest information on AirPort Extreme, go to www.apple.com/airport.

To register AirPort Extreme (if you didn’t do so when you installed the software on the 
AirPort Extreme CD), go to www.apple.com/register.

For AirPort service and support information, a variety of forums with product-specific 
information and feedback, and the latest Apple software downloads, go to 
www.apple.com/support/airport.

For support outside of the United States, go to www.apple.com/support, and then 
choose your country from the pop-up menu.
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Onscreen Help
m To learn more about using AirPort, open AirPort Utility and choose Help > AirPort Help.

Obtaining Warranty Service
If the product appears to be damaged or does not function properly, please follow the 
advice in this booklet, the onscreen help, and the online resources. 

If the base station still does not function, go to www.apple.com/support for 
instructions about how to obtain warranty service.

Finding the Serial Number of Your AirPort Extreme
The serial number is printed on the bottom of your AirPort Extreme.
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AirPort Specifications
Â Wireless Data Rate:  Up to 54 megabits per second (Mbps)

Â Range:  Up to 150 feet (45 meters) in typical use (varies with environment)

Â Frequency Band:  2.4 and 5 gigahertz (GHz)

Â Radio Output Power:  15 dBm (nominal)

Â Standards:  802.11 DSSS 1 and 2 Mbps standard, 802.11b, 802.11g, 802.11a, and draft 
802.11n specifications

Interfaces
Â RJ-45 Ethernet LAN connector for built-in 10/100Base-T (G)

Â Universal Serial Bus (USB) printing (d)

Â AirPort Extreme

Environmental Specifications
Â Operating Temperature:  32° F to 95° F (0° C to 35° C)

Â Storage Temperature:  –13° F to 140° F (–25° C to 60° C)

Â Relative Humidity (Operational):  20% to 80% relative humidity

Â Relative Humidity (Storage):  10% to 90% relative humidity, noncondensing

Size and Weight
Â Height:  6.50 inches (165.0mm)
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Â Width:  6.50 inches (165.0mm)

Â Thickness:  1.34 inches (34.0mm)

Â Weight:  1.66 pounds (753 grams)

Hardware Addresses
The AirPort Extreme has two hardware addresses printed on the bottom of the case:
Â AirPort ID:  The address used to identify AirPort Extreme on a wireless network.

Â Ethernet ID:  This also known as the MAC address. You may need to provide this 
address to your ISP to connect AirPort Extreme to the Internet.

Using AirPort Extreme
Â The only way to shut off power completely to your AirPort Extreme is to disconnect it 

from the power source.

Â When connecting or disconnecting your AirPort Extreme, always hold it by its sides. 
Keep fingers away from the metal part of the plug.

Â Your AirPort Extreme is a high-voltage component and should not be opened for any 
reason, even when the AirPort Extreme is unplugged. If your AirPort Extreme needs 
service, see “Learning More, Service, and Support” on page 33. 

Â Never force a connector into the ports. If the connector and port do not join with 
reasonable ease, they probably don’t match. Make sure that the connector matches 
the port and that you have positioned the connector correctly in relation to the port.
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About Operating and Storage Temperatures
When you are using your AirPort Extreme, it is normal for the case to get warm. The 
AirPort Extreme case functions as a cooling surface that transfers heat from inside the 
unit to the cooler air outside.

Avoid Wet Locations

Â Keep AirPort Extreme away from sources of liquids, such as drinks, washbasins, 
bathtubs, shower stalls, and so on.

Â Protect AirPort Extreme from direct sunlight and rain or other moisture.

Â Take care not to spill any food or liquid on your AirPort Extreme. If you do, unplug 
AirPort Extreme before cleaning up the spill.

Â Do not use AirPort Extreme outdoors. AirPort Extreme is an indoor product.

Do Not Make Repairs Yourself

About Handling
Your AirPort Extreme may be damaged by improper storage or handling. Be careful not 
to drop your AirPort Extreme when transporting the device.

Warning:  To reduce the chance of shock or injury, do not use your AirPort Extreme in 
or near water or wet locations.

Warning:  Do not attempt to open your AirPort Extreme or disassemble it. You run 
the risk of electric shock and voiding the limited warranty. No user-serviceable parts 
are inside.
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!

Communications!Regulation!Information

!

Wireless!Radio!Use

!

This!device!is!restricted!to!indoor!use!due!to!its!
operation!in!the!5.15!to!5.25!GHz!frequency!range!to!
reduce!the!potential!for!harmful!interference!to!co-
channel!Mobile!Satellite!systems.

Cet!appareil!doit!être!utilisé!à!l’intérieur.

!

Exposure!to!Radio!Frequency!Energy

!

The!radiated!output!power!of!this!device!is!well!below!
the!FCC!radio!frequency!exposure!limits.!However,!this!
device!should!be!operated!with!a!minimum!distance!of!
at!least!20!cm!between!its!antennas!and!a!person's!
body!and!the!antennas!used!with!this!transmitter!must!
not!be!co-located!or!operated!in!conjunction!with!any!
other!antenna!or!transmitter!subject!to!the!conditions!
of!the!FCC!Grant.

!

FCC!Declaration!of!Conformity

!

This!device!complies!with!part!15!of!the!FCC!rules.!
Operation!is!subject!to!the!following!two!conditions:!(1)!
This!device!may!not!cause!harmful!interference,!and!(2)!
this!device!must!accept!any!interference!received,!
including!interference!that!may!cause!undesired!
operation.!See!instructions!if!interference!to!radio!or!
television!reception!is!suspected.

!

Radio!and!Television!Interference

!

This!computer!equipment!generates,!uses,!and!can!
radiate!radio-frequency!energy.!If!it!is!not!installed!and!
used!properly—that!is,!in!strict!accordance!with!Apple’s!
instructions—it!may!cause!interference!with!radio!and!
television!reception.

This!equipment!has!been!tested!and!found!to!comply!
with!the!limits!for!a!Class!B!digital!device!in!accordance!
with!the!specifications!in!Part!15!of!FCC!rules.!These!
specifications!are!designed!to!provide!reasonable!
protection!against!such!interference!in!a!residential!
installation.!However,!there!is!no!guarantee!that!
interference!will!not!occur!in!a!particular!installation.

You!can!determine!whether!your!computer!system!is!
causing!interference!by!turning!it!off.!If!the!interference!
stops,!it!was!probably!caused!by!the!computer!or!one!of!
the!peripheral!devices.

If!your!computer!system!does!cause!interference!to!
radio!or!television!reception,!try!to!correct!the!
interference!by!using!one!or!more!of!the!following!
measures:
Â

!

Turn!the!television!or!radio!antenna!until!the!
interference!stops.

Â

!

Move!the!computer!to!one!side!or!the!other!of!the!
television!or!radio.

Â

!

Move!the!computer!farther!away!from!the!television!or!
radio.

Â

!

Plug!the!computer!into!an!outlet!that!is!on!a!different!
circuit!from!the!television!or!radio.!(That!is,!make!
certain!the!computer!and!the!television!or!radio!are!on!
circuits!controlled!by!different!circuit!breakers!or!
fuses.)

If!necessary,!consult!an!Apple!Authorized!Service!
Provider!or!Apple.!See!the!service!and!support!
information!that!came!with!your!Apple!product.!Or,!
consult!an!experienced!radio/television!technician!for!
additional!suggestions.
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!

Important:!

!

Changes!or!modifications!to!this!product!not!
authorized!by!Apple!Computer,!Inc.!could!void!the!EMC!
compliance!and!negate!your!authority!to!operate!the!
product.

This!product!was!tested!for!FCC!compliance!under!
conditions!that!included!the!use!of!Apple!peripheral!
devices!and!Apple!shielded!cables!and!connectors!
between!system!components.!It!is!important!that!you!
use!Apple!peripheral!devices!and!shielded!cables!and!
connectors!between!system!components!to!reduce!the!
possibility!of!causing!interference!to!radios,!television!
sets,!and!other!electronic!devices.!You!can!obtain!Apple!
peripheral!devices!and!the!proper!shielded!cables!and!
connectors!through!an!Apple-authorized!dealer.!For!
non-Apple!peripheral!devices,!contact!the!manufacturer!
or!dealer!for!assistance.!

!

Responsible!party!(contact!for!FCC!matters!only):!

!

Apple!
Computer,!Inc.,!Product!Compliance,!1!Infinite!Loop!M/S!
26-A,!Cupertino,!CA!95014-2084,!408-974-2000.

!

Industry!Canada!Statement

!

Complies!with!the!Canadian!ICES-003!Class!B!
specifications.!This!device!complies!with!RSS!210!of!
Industry!Canada.

Cet!appareil!numérique!de!la!classe!B!est!conforme!à!la!
norme!NMB-003!du!Canada.

!

VCCI!Class!B!Statement

Europe!—!EU!Declaration!of!Conformity

!

The!equipment!complies!with!the!RF!Exposure!
Requirement!1999/519/EC,!Council!Recommendation!of!
12!July!1999!on!the!limitation!of!exposure!of!the!general!
public!to!electromagnetic!fields!(0!Hz!to!300!GHz).!This!
equipment!meets!the!following!conformance!standards:!
EN300!328,!EN301!893,!EN301!489-17,!EN60950.

Hereby,!Apple!Computer,!Inc.,!declares!that!this!device!is!
in!compliance!with!the!essential!requirements!and!other!
relevant!provisions!of!Directive!1999/5/EC.

!

Disposal!and!Recycling!Information

!

AirPort!Extreme!has!an!internal!battery.!Please!dispose!
of!it!according!to!your!local!environmental!laws!and!
guidelines.!For!information!about!Apple's!recycling!
program,!go!to
www.apple.com/environment.

!

European!Union!+!Disposal!Information:

!

This!symbol!means!that!according!to!local!laws!and!
regulations!your!product!should!be!disposed!of!
separately!from!household!waste.!When!this!product!
reaches!its!end!of!life,!take!it!to!a!collection!point!



!

designated!by!local!authorities.!Some!collection!points!
accept!products!for!free.!The!separate!collection!and!
recycling!of!your!product!at!the!time!of!disposal!will!
help!conserve!natural!resources!and!ensure!that!it!is!
recycled!in!a!manner!that!protects!human!health!and!
the!environment.

!

Deutschland:!!

!

Dieses!Gerät!enthält!Batterien.!Bitte!nicht!
in!den!Hausmüll!werfen.!Entsorgen!Sie!dieses!Gerätes!
am!Ende!seines!Lebenszyklus!entsprechend!der!
maßgeblichen!gesetzlichen!Regelungen.

!

Nederlands:

!

!!Gebruikte!batterijen!kunnen!worden!
ingeleverd!bij!de!chemokar!of!in!een!speciale!
batterijcontainer!voor!klein!chemisch!afval!(kca)!worden!
gedeponeerd.

!

Taiwan:

!

©!

©!2006!Apple!Computer,!Inc.!All!rights!reserved.
Apple,!the!Apple!logo,!AirPort,!Bonjour,!iTunes,!Mac,!
Macintosh,!and!Mac!OS!are!trademarks!of!Apple!
Computer,!Inc.,!registered!in!the!U.S.!and!other!
countries.!AirPort!Extreme,!AirTunes!are!trademarks!of!
Apple!Computer,!Inc.

!

www.apple.com/airport
www.apple.com/support/airport

!
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